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Safety Precautions and
Warnings

Qualified
Personnel

Use as prescribed

Trademarks

This manual contains warnings, which you should note for your own safety as well as for
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Danger
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Caution
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Note
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Preface

Preface

Purpose of the
Manual

Contents of the
Manual

Scope of this
Manual

How to Access the
Information in this
Manual

The information in this manual allows you to set up and put in operation the
connection between the CP 343-1/CP 443-1 and a device that supports the
Open MODBUS/TCP protocol.

This manual describes the function of the function block MODBUSCP and
its integration into the hardware and software of the communication
processors CP 343-1/CP 443-1.

The manual contains the following topics:
e Production description / Mounting

e Getting Started

e Commissioning

e Parameterization

e Licensing

e Function block MODBUSCP

e Diagnostics

e Application samples

This manual is valid for the following software:

Product Identification number From version
OPEN MODBUS / TCP 2XV9 450-1MB00 4.3

FB 108 “MODBUSCP” 1.3/2.2

FB 106 “MB_CPCLI" 1.2/2.2

FB 107 “MB_CPSRV” 1.2/21
Note

This manual contains the FB description, as it is valid at the time of
publication.

To enable you a quick access to selected information, the manual provides
the following access aids:

e The next pages contain a complete table of contents.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 1
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Preface

Additional
Sources of
Information

Additional
Questions

Terminology

All additional information concerning CP 343/CP 443 (mounting,
commissioning etc.) can be found in the manual

SIEMENS

SIMATIC NET

S7-CPs for Industrial Ethernet
device manual C79000-G8900-C155

SIEMENS

SIMATIC NET

S7-CPs for Industrial Ethernet
device manual part B1

CP 343-1/ CP 343-1EX20
C79000-G8900-C158

SIEMENS

SIMATIC NET

S7-CPs for Industrial Ethernet
device manual part B4

CP 443-1
C79000-G8900-C152

SIEMENS

SIMATIC NET

NCM S7 for Industrial Ethernet
manual C79000-G8900-C129

Additional information concerning STEP7 can be found in the following
manuals:

SIEMENS

SIMATIC Software

Base software for S7 and M7
STEP7 user manual
C79000-G7000-C502-..

SIEMENS

SIMATIC Software

System software for S7-300/400

System and standard functions

Reference manual C79000-G7000-C503-02

If you have further questions regarding the use of the FBs described in this
manual, which are not answered in this document, please contact your
Siemens partner who supplied you with this function block.

This document uses the term CP or CP 343/CP 443. The descriptions only
apply to communications processor CP 343-1/CP 443-1.

Scope of The function block described in this manual establishes a connection
Application between the CP 343-1/CP 443-1 and third party MODBUS devices.
OPEN MODBUS / TCP communication via CP343-1 and 443-1 2
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Product description

1 Product Description

1.1 Field of Applications

Placement in the
System Environ-
ment

Function of the
FBs

TCP/IP with
CP343-1/CP443-1

The driver described here is a software product for the Communications
Processor CP343-1/CP443-1.

The CP343-1 can be used in the SIMATIC S7-300 automation system and
can establish communication links to partner systems.

CP443-1 can be used in the SIMATIC S7-400 automation systems and can
establish communication links to partner systems.

These function blocks enable a communication link between CP343-1 /
CP443-1 and a device that supports the Open MODBUS/TCP protocol. The
function codes 1, 2, 3, 4, 5, 6, 15 and 16 are provided.

Data transmission is carried out following the Client-Server principle.

The SIMATIC S7 can act as both client and server during the data
transmission.

TCP/IP with CP343-1 and CP434-1 uses static connections. The TCP
connection is not disconnected during errror-free operation.

Network configuration of STEP7 enables only a unique use of a specific
port number, when using TCP native stack of the CP.

However, with specific CP modules it is possible to use multiple connection
via port 502 to different clients simultaneously.

In section 3.6 “Mulitple connections via port 502” you can find technical details
regarding this matter.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 1-1
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Product description

1.2 Hardware and Software Prerequisites

Usable Modules You can find the latest hardware prerequisites on the internet:
www.siemens.com/s7modbus.

Software Versions The usage of the modbus blocks is possible with STEP7 Version 5.4 or
higher. Withal the use of the blocks AG_LSEND/AG_LRECV V3.1 of the
update of SIMATIC NET library
(http://support.automation.siemens.com/WW/view/en/22172239) is required.

Memory The FB MODBUSCP requires ca. 6k byte work and load memory.
requirements
The FB MB_CPCLI requires ca.10k byte work and memory.

The FB MB_CPSRYV requires ca. 10 k byte work and load memory.

The particular length of the blocks can be determined in the properties of the
block in the Simatic Manager.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 1-2
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Getting started

2 Getting Started

Procedure

Install “OpenModbusTCP CP“.
=> Section 3.1

Parameterize the connection parameters regarding your requirements
(IP-address, port number, etc.).
=> Section 3.2t0 3.4

Insert the Modbus function blocks into your SIMATIC project.
=> Section 3.6

Call the Modbus block FB108 in the required OBs.
=> Section 5.1

Parameterize the Modbus block for initialization (client/server, DB areas,
Modbus addresses) and runtime.
=> Section 5.2

Load the user program into the PLC and license the Modbus block for this
CPU.
=> Section 4

OPEN MODBUS / TCP communication via CP343-1 and 443-1 2-1
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Commissioning

3 Commissioning

General
Information

Requirements

The configuration of the CP443-1/CP343-1 is possible via MPI or
LAN/Industrial Ethernet.

STEP7 is required with NCM S7 for Industrial Ethernet (shortly named
"NCM IE").

The information below about STEP7 and the communication link configuration
refers to STEP7 Version 5.1 and NCM S7 Industrial Ethernet Version 5.1.

In later versions, the sequences, names and directories might be different.

Knowledge of AWL and basic knowledge of STEP7 and PLC.

3.1 Installing the Library on the STEP7 PG/-PC

What We Provide
You

Requirements

Installation

The attached CD contains a setup, which installs the library
“Modbus_TCP_CP”, 2 example projects and the manuals in English and
German in the corresponding STEP7 directories.

The manuals are available outside the setup additionally, to give you the
opportunity to get all information regarding the software without installation.

To install, STEP7 must be installed. With older STEP7 versions the option
NCM S7 for Industrial Ethernet is necessary additionally.

Insert your Modbus CD into the CD-ROM drive and follow step-by-step the
instructions that are automatically displayed by the installation program. If the
installation program fails to automatically run, perform these steps:

1. Using Windows Explorer, navigate to the CD-ROM drive and go to the
directory setup and double-click Setup.exe file to start the installation
procedure.

2. Follow step-by-step the instructions that are displayed by the installation
program.

Now you can find

e thelibrary in \Program Files\Siemens\Step7\S7libs,

e 2 example projects in \Program Files\Siemens\Step7\Examples,

e the manual in \Program Files\Siemens\Step7\S7manual\S7Comm,

o the software registration form in
\Program Files\Siemens\Step7\S7libs\Modbus_TCP_CP.

To access the Modbus library the first time, use the browse function of the
open dialog for libraries.

The manual can be accessed via short cut in \Program Files \Siemens
\Documentation as well.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-1
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3.2 Parameterization of the CP

Parameterization If you have your stations connected with each other without a router, then

of the CP they have to be within the same subnet.
In the field Subnet connect the CP with the Industrial Ethernet. In order to do
that, select the entry with the name of your network. For newly created
networks this is normally “Ethernet(1)".

Properties - Ethernet interface CP 443-1 (RO/S5) 5[

General  Parameters |

[T SetMAL address / use 150 pratocal
MALC address: I

¥ P protocal is being used

IP address: [t00041 Liateway

&' Do not use router
Subnet mask: |255. 0.o0.ao

 Use router

Address: I'I 00041
Subnet:

-- rok metworked - - Mew. .. |
Ethernet(1

Froperties... |

Ethernet(5] j Delate |

Cancel | Help |

Save and Compile the parameterization.

OPEN MODBUS / TCP communication via CP343-1 and 443-1
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Parameterization In the mode “CP is client” an “other station” is required for network

of the configuration.

Communication

Partner After you have inserted the communication partner’s station into your STEP7

project (as described in “Project components: Insert » Other station“) you
have to specify the object properties of the external station.

1) Properties — Other Station > Interfaces

On the tab “Interfaces*” click on “New". In the upcoming selection, select
“Industrial Ethernet” and click on “OK”.

Properties -Other station %]
General  Interfaces |
Mame | Type | Address | Subnet |
x|
Mew... Delete |
0K I Cancel Help |
Ll Cancel | Help |

This opens a dialog box “Properties — Ethernet Interface”. Enter an IP
Address that is in the same subnet as the communication partner’s station.
The subnet mask should be the same as the one of the partner’s station.
Select the associated subnet that connects the CP interface with the
communication partner’s interface.

Properties - Ethernet interface x|

General  Parameters |

[T SetMAL addrezs / use 150 protocol

MALC address: I If & subnet iz selected,

the nest available addresses are suggested,

¥ | P protacsl is beita used

Gates
IP address: 10.0.0.31 iy
acdress — | © Donotuse router
Subnet mask: 285.0.0.0

" Use router

Address: |1D.D.D.31
Subnet:
- hat networked - - Mew... |
Ethernet/1

Froperties... |
Ethernet[4]
Etheret(5] LI &l
el ||

Click on the “OK*" button. This will bring you back to the tab “Interfaces".

OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-3
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Properties -Other station 5[

General  Interfaces |

Marme | Type | Address | Subnet |
Ethernet port{1] Industrial Ethemet 10,003 Ethernet(2]

Mew... Froperties... Delete |

0K, | Cancel Help

2) Properties — Other Station»General

In tab “General” you do not have to make any settings.

3.3 Network Configuration

Communications The CP is the link for the Industrial Ethernet connection between the S7-CPU
Connection and the communication partner / bus. A connection configuration must be
made for the connection of the interfaces to the communication partner / bus.

Configure Network In the STEP7 project, select the CPU in your S7 300/S7 400-Station and open

in mode “CP is “Network configuration® by double clicking “Connections”. This opens the
Client” program “NetPro* with which your connections can be configured.
OPEN MODBUS / TCP communication via CP343-1 and 443-1 34

2XV9450-1MBO00; Manual edition 4.3



Commissioning

After selecting Insert>» New Connection... the dialog box "Insert new
connection® will come up.

i:‘,!__%NetPru - [MODBUS_TCP_CP_EXAMPLE {Metwork) - MODBUS_TCP_CP_EXAMPLE]

98 yetwork  Edb Insert PLC Wiew Options Window Help

EE RS R ki8S BEa s

Etherneti1)
Industrial Ethernet

SIMATIC 400(Client)

-I Cther station(Servert)
=

onnection Cerl+

Download selected| connections

ShowfHide Columns 3
Cptinize Colurmn Width
Displary Columns. ..

Select the connection partner (Other Station) for the new connection and use
“TCP Connection” for the connection. Put a check mark on “Show properties
dialog”

Insert New Connection il

r— Connection Partner

E--{E] I the current project

E@ MODBUS_TCP_CP_ExaMPLE
----- 5 Other i)
----- 5 Other station[Serverz]
-l SIMATIC 300[Client)

- SIMATIC 300[S erver]
E-E SIMATIC 400[S erver]

[Unzpecified]

All broadcast stations
------------ All multicast stations
% Ih unknown project

. ]
Praject: IMDDEUS_TEF‘_EF‘_EX&MF‘LE =
Station; IDther station[Serverl]

I odule; |
— Conmection
Type: I TCF cannection j

¥ Display properties befare inserting

QK I Apply | Cancel | Help |

Click “OK". This will take you back to the dialog box “Properties TCP
connection®.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-5
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Object Properties e An D is provided. You can change the ID if needed.
of the Connection e Click on the button “Routing” and the configured connection will be shown.
e The MODBUS client must execute “Active connection establishment”.

Properties - TCP conneckion il
Options | Overview | Status Infarmation
General Infarmation Addrezzes
— Local Endpaint — Block Parameters
1D [hex): 0001 A050

1—ID

M arne: ITEF‘ connection]d Wi EHOTFC —lLADDR

Wia CP: |cp 4431 - [RO/55)

Route. .. |

¥ fglive connection establishment

Cancel | Help |

¢ In the register “Addresses” the port numbers are defined.

Properties - TCP connection ll
Optionz Overview | Statusz Information |
General Information Addreszes

Farts from 1025 through B5535 are available.
[Far further ports, refer to anling help)

Local Remote
P [dec]: |1 0.0.0.41 [
FORT [dec): |m |502

Cancel | Help |

Click on “OK" and the inputs are accepted.

Save the network configuration and close the program “NetPro".

Please note that the connection ID (Local ID) has to be used when the FB is
called in the user program.

Selection of the In a MODBUS communication a MODBUS server are normally addressed via
Port Number port 502, whereas a MODBUS client uses a port from 2000.
OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-6
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Unspecified If you have got a communication with CP as MODBUS server, the
Connection with communication is set up as “unspecified connection”. The client must carry
“CPis server” out active connection establishment.

After selecting Insert>» New Connection... the dialog box "Insert new
connection® will come up.

‘ﬁ%NEtPrD - [MODBUS_TCP_CP_EXAMPLE (Network) -- MODBUS_TCP_CP_EXAME
B network Edit Insert PLC Wiew Options Window Help

8 S a8 L Ba

Ethernet(4)
Inciustrial Ethernet

SIMATIC Z00(Server)

. |Local ID

Downlead selected conmections

ShowiHide Colurins 3
Dptimize Column Width
Display Columns., ..

Select here “unspecified” instead of the communication partner and use
“TCP Connection” for the connection. Put a check mark on “Show properties
dialog”

Insert New Connection il

— Connection Partrer

=-[&] In the curent project

E% MODBUS_TCP_CP_ExAMPLE
----- 5 Other station[Serverl)

----- 5 Other station[Server2)
H-Fl SIMATIC 300[Client]
H-F SIMATIC 400[Client)
=-F] SIMATIC 400[Server)

’ CPU 4

[Unspecified)
All broadeast stations
------------ All multicast stations
% I unknown project

t
Froject: | $
Station; |[Unspecified]
ol mduile; |
— Connection
Type: ITEF‘ cohnection j

[¥ | Display properties befare inserting

Ok I Apply Cancel | Help |

OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-7
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Click “OK". This will take you back to the dialog box “Properties TCP
connection®.

The check box “active connection establishment” must not be activated.

Properties - TCP connection 5[
Dptions | Dwerview I Status Information
General Information Addresses
— Local Endpoint — Block Parameters
: 0002 A050
1D [hex): 0002 A060 a o

Marme: ITCF' connection35 WHTERI7EC —LADDR

Yia CP; |CF' 4431 - [RO/SE]

Route... |

[" Active connection establishment

™ Use FTP protocol

Cancel | Help |

In the register “addresses” all information regarding the partner, “IP” and
“PORT" are left blank.

Properties - TCP conneckion 1'
Optiohs Overview | Statusz Information |
General Information Addreszes

Paorts from 1025 through 5535 are available.
[Far further ports, refer to onling help)

Local Fiemate
IP (dec): |1 0.0.0.42 ||
PORT (dec): 502 |

Click on “OK" and the inputs are accepted.

OPEN MODBUS / TCP communication via CP343-1 and 443-1
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3.4 How to Select the Appropriate Modbus Block

General
Information

Which CPs
support
AG_CNTRL?

The block FC10 AG_CNTRL of the SIMATIC_NET library permits to terminate
and reestablish an established connection. This block was also implemented
in the Modbus blocks for a more effective use of the resources of CPU and
CP. However, previous CPs or previous firmware releases do not support the
use of AG_CNTRL.

Therefore the library contains directories for both alternatives, each for
S7-300 CPs and S7-400 CPs:

e Current CP 300 CPs of S7-300 which support AG_CNTRL
(not for CPU315 and 317 HW release V1)

e Current CP 400 CPs of S7-400 which support AG_CNTRL

e Previous CP 300 CPs of S7-300 which do not support
AG_CNTRL

e Previous CP 400 CPs of S7-400 which do not support
AG_CNTRL

Pay attention to the count of local data of the used CPU! The required
local data for both alternatives are written in chapter 5.4.
% Modbus_TCP_CP -- C:Program Files"-.,5ien1ens"-.,StEpT"-.,-"E = |EI|5|
E@ Object name Symbolic name I Type

iﬁl Cument CF 300 (2] Current CP 300 57 Program

@ Eurrgnt LR 400 (=] Current CP 400 57 Program

" E'EVPUS EE igg [£2] Previous CF 300 57 Program

) (z1) Previous Previous CP 400 57 Program

1] | ]

Here you can find up-to-date information which CPs and which firmware
releases support AG_CNTRL:
Ethernet CPs and AG_CNTRL

If the used CP is not mentioned here, the Modbus blocks without AG_CNTRL
must be used.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-9
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3.5 Insertion of the Function Blocks into the Program

Content of

MODBUS library

Insertion of the

The following blocks are required for the Modbus communication:
e MODBUSCP
e MB_CPCLI
e MB_CPSRV

%= Modbus_TCP_CP -- C:\Program Files'Siemens’Step7\S7L B ]
E@ Modbus_TCP_CP Object na.. i Symbolic name | Creat.. | Tupe | Wersion [
A Current CF 300 ZFFEI0E  MB_CPCLI SCL Function Elock 22

(B RE&D -IMPORTANT! o3 ppo7 MB_CPSRY  SCL Function Block 2.1
Z3FEI08  MODBUSCP  SCL Furction Block 2.2

(+)-(31) Current CP 400

: 3+ DB3 LICENSE_DB LB Data Block 0.1
(2 Previous CP 300 - e
#-{z1] Previous CP 400 q | N

In order to exchange data with MODBUS devices, you need the function

MODBUS FBs blocks MODBUSCP, MB_CPCLI, MB_CPSRV and AG_CNTRL if applicable.
To be able to insert this into your project you have to copy the function block
from the library. For that, open the library “Modbus_TCP_CP* by selecting
the menu item File » Open.
In the dialog box “Open Project” select the tab " Libraries”. Select the library
“Modbus_TCP_CP” using the Browse-Button and click “OK”.
This opens the library. Open the folder “CP 300" or “CP 400" according to
your Configuration by double clicking it. Select the function blocks and copy it
via “Edit » Copy”. Then change back to your project .
In the Step7 project, in your opened S7 300/S7 400-Station, select the CPU.
Double click “ S7-program”, and then “Blocks”.
This will open the “Blocks” folder.
Select “Edit » Paste”. This will insert the block into your program.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-10
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Insertion of the
Communication
Blocks

CP 300

CP 400

The Modbus function blocks use the function blocks AG_SEND and
AG_RECV in S7-300 or AG_LSEND and AG_LRECYV in S7-400.

You can find these communication function blocks in the library
“SIMATIC_NET_CP* which are included in the software package NCM S7
for Industrial Ethernet.

Copy the functions FC5 (AG_SEND) and FC6 (AG_RECYV) from the folder
“CP 300" and insert in your project.

Copy the functions FC50 (AG_LSEND) and FC60 (AG_LRECV) from the
folder “CP 400" and insert in your project.

Please note, that the following versions of the FCs are a prerequisite for the
faultless function of the FB MODBUSCP:

S7-400: AG_LSEND V3.1 or higher
AG_LRECV V3.1 or higher

S7-300: AG_SEND V4.2 or higher
AG_RECV V4.7 or higher

OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-11
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3.6  Multiple Connections via Port 502

General

Pre-requisits

Number of
Connections

Displaying the
Status of the
Connection

Characteristics of
the Error Handling

Tip for your User
Program

Some CP modules are able to multiplex TCP connections. In doing so several
Modbus clients can establish a connection via port 502. The CP acts as
Modbus server.

Here you can find information which CP and which firmware release support
multiple connections via port 502:
www.siemens.com/s7modbus

To use the functionality, the parameterization must be carried out as follows:
e CPisserver
e port 502 as local port
e unspezified TCP connection in NETPRO

e passive connection establishment

Please note that only 1 connection is parameterized in NETPRO irrespective
of the number of clients which address the CP as server.

The CP is capable to keep up to 8 connections to different clients. A ninth
attempt for connection establishment will be rejected.

The status of the connection is displayed even in NETPRO online as well as
in special diagnosis of the CP.

As only 1 connection is parameterized in NETPRO, the display shows the
status of all TCP connections to the several clients.

As long as no client has established a connection “Passive connection
establishment in progress" is displayed.

As soon as one client has established a connection “established” is displayed.
It is not possible to check how many clients have actually established a
connection to the CP.

The FB MODBUSPN and the CP respectively must terminate and reestablish
the connection in certain error situations. This action is carried out by the FB
MODBUSPN. Thereby all existing connections via port 502 are terminated.

When several connections are established via port 502, it is not possible to
identify the client which has sent the recent request.

If the clients use different UNIT numbers, the verification of the same in the
user program allows a determination.
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3.7 Start_up Characteristics of CP343 / CP443

Introduction The start up of the CP is divided into the following phases:
e [Initialization (Power on of the CP)

e Parameterization

Initialization As soon as the CP is connected to power, the hardware self test runs. The
firmware of the CP is set up for operation.

Parameterization During parameterization the CP receives the device parameters that are
assigned to its slot.

The CP is now ready for operation.
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3.8 Changeover of a Previous Version to V4.x

General
Information for
Changeover to
V4.0

Procedure for

Changeover to
V4.0

Notes to V4.3

If a previous version of "ModbusTCP CP" is already used, some changes
must be carried out in the S7 program. An update with the menu “file” ->
"check and update access" is not possible because the interface of the block
has changed.

1.

Copy the new Modbus blocks FB106, FB107, FB108 and DB3 into your
project.,You can rename the modbus blocks, if these block numbers are
already used.

Open the blocks, in which the modbus blocks have been called so far
(OB100 and cyclical OB).

Call the new block FB108 MODBUSCP directly after the prior MODBUS
or MODBA4 call with a new instance DB.

Transcribe the following parameters of MODBUS or MODB4 to
MODBUSCP depending on the calling OB.

id, laddr, MONITOR, db_0to db_8, ENQ_ENR, server_client,
START_ADDRESS, LENGTH, WRITE_READ, INPUT_HOLDING, TI,
UNIT, DONE_NDR, ERROR and STATUS.

Capital letters represent runtime parameters, small letters initialisation
parameters.

Add suitable values to the new parameters:

REG_KEY, single_write, data_type_x, LICENSED, BUSY and
STATUS_FUNC. It is not necessary to allocate the parameter
IDENT_CODE.

You can find the description of the new parameters in the parameter list in
section 5.2.

The output parameters are displayed dynamically, i.e. they are only
available for one PLC cycle. They have to be copied to an additional

memory area if you need to process them or to display the values in a
VAT (STEP7 variable table).

Adapt your program correspondingly.

Insert the programming fault block OB121 in your program if this has not
been included yet. This block is necessary for the licensing, see section
"licensing" for further information.

Delete the previous Modbus call or comment it out. Load the program into
the CPU and execute a restart of the CPU.

Here you find information to V4.3: www.siemens.com/s7modbus, tab
“Downloads”.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 3-14
2XV9450-1MB00; Manual edition 4.3


http://www.industry.siemens.com/industrial-services/it/en/products/simatic_add_ons/s7_open_modbus_tcp.htm

Licensing

4  Licensing

General

Read the
IDENT_CODE

The block MODBUSCP must be licensed for each CPU individually. The
licensing takes place in two steps: reading the IDENT_CODE and declaring

the registration key REG_KEY. The OB121 must be available in the CPU.

To read the IDENT_CODE please proceed as follows:

1. Parameterize the block MODBUSCP in the cyclic OB (OB1 or cyclic
interrupt OB) and in OB100 according to your requirements. Transfer

the program to the PLC and turn it to RUN mode.

2. Open the instance DB of the block MODBUSCP. , Data block” ->

»,Open Online" to open the DB.

Monitoring the block via the button is insufficient.

[E5IDB Param - DE108

Daka block Edit PLC Debug ‘iew ‘Window Help
Open. ..

Cpen Online

Close

Chr+O

]

Save
Properties...

Chrl+5

Prink. ..
Prink Preview. .,
Page Setup...

Chrl+P

1 MODEUS_TCP_CP_EXAMPLE|SIMATIC 400{Clent)iCPU 416-2 DFY, .,

2 Prig)PLC 1-5UBLCPU 414-2 DRY,,.\DE731
3 Prio}PLC 1-5UBNCPU 414-2 DRY.,.\DBS31
4 Modbus_a01EVSIMATIC 300{11,CPU 315-2 PNJDPY,. \DE44

Exit

13 40.0 |in start_2

WORD

14 420 |in end_2
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3. The output IDENT_CODE shows an 18 character string

Copy this string per copy/paste from the DB und and insert it in the
form IT4Industry SOFTWARE REGISTRATION FORM. This form is

stored in the library path

.\Program Files\Siemens\Step7\S7LIBS\Modbus_TCP_CP
during installation and is also available on the installation CD.
Insert the License-No. of the product package into the form.

zg DB Param - [DBE108 -- MODBUS_TCP_CP_EXAMPLE',SIMATIC 400(Client)'\CPU 41... ;Iglﬂ
@ Datablock Edit PLC Debug Wiew Mindow Help ==l
BRES| oo 4 BRI b de W2
Address | Declar | Mame Type Initial walue | Actual value ;I

34 820 |in end_7 WORD W1 G0 V1 GREFC [
35 840 |in data_type 8 BYTE B#16#0 B#16#0

36 860 |in db_& WORD Wi B0 Wit B0

37 &80 |in start_& WORD Vi1 B0 i1 G0

38 800 |in end_{ WORD Vi1 G0 W1 G0

39 920 |in EMGQ_ENR BOOL FALSE FALSE

40 940 |out LICENSED BOOL FALSE TRUE

41 941 |out BUSY BOOL FALSE FALSE

42 94 2 | oLt DOMNE_MDR: BOOL FALSE FALSE

43 94.3 |out ERROR BOOL FALSE FALSE

44 960 |out STATUS WORD Wit B0 Nasals

45 950 | oLt STATUS_FUNC STRING [ & ] "

46 1080 |out IDENT_CODE STRING [18] |" FHJllFDEMHlDEFHDDZ']

47 1260 |in_out | UNIT BYTE B#16#0 B#1680

43 129.0 |in_out |DATA_TYPE BYTE B#1E#0 El#)é#ﬂ

49 1300 |in_out |START_ADDRE WORD Vi1 B0 W#1 E#0

50 1320 |in_out |LENGTH WORD Vi1 G0 W1 G0

Sl 1340 |in_out | T WORD Vi1 BR0 Vi1 GR0

52 136.0 |in_out |WRITE_READ BOOL FALZE FALZE ;I
4| A ¥
Press F1 for help. /o I

Please insert the IDENT-CODE here.
The manual contains information how to find oyfthe IDENT-CODE.

Bitte tragen Bie den IDENT-CODE hier e

Das Handbuch enthilt Informationen, wiedSie den IDENT-CODE ermitieln.

>=> [DENT_CODE <<=

Hl|||aal|a|u!; |

Please insert the License-Mo. here.
You find the License-Ho. on the package of the p)

Bitte tragen Bie die Lizenz-Nr hier ein
3ie finden die Lizenz Nr. auf der Verpackung dey

=== License-No / Lizenz-Nr <=4

|

Type of Softwanre # Softwaretyp: Auntime Saftmare

|
=
==

57-0penModbus(TCP
RV

Ty ol License | Lizenatyp: Single Leense
Tope of Use | Art der Wutaangs S0
o, i Anzahl: |
Softwaare Clags FSoftmar st ie: A
Reference hardware [ Ziolharcrore:
SIMATC FHCPU
P
Sypstens Candtions [ Systemanta ey
CUCER TR

Rarrark L Anmetkung
Softvaare ond electronic documnentation or €D

reer bo, { Bestell e 2KV95 55
Liew 148 4o, | Lizenz N ; 209596.C101 00001

———

M3 SMIGINAL IMBUSTRLAL SOFTWARE SIEMERS SRIGINAL INDUSTAIAL 50

4. Please send the form per e-mail to IT4Industry

it4.industry@siemens.com.

Hereupon you will receive the registration key for your PLC.

Please note: No ident code can be displayed as long as an initialisation error
exists. Evaluate the output STATUS and correct the parameterization.
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Declaration of the The registration key REG_KEY must be declared for each call of the block
Registration Key MODBUSCP.
REG_KEY

The registration key REG_KEY should be stored in a global DB. Via this
global DB all MODBUSCP blocks can receive the registration key (See also
the following example).

Please proceed as follows to declare the registration key REG_KEY:
1. Copy the prepared license block DB3 of the library
“Modbus_TCP_CP* into your project. If the DB number is already

used in your project, rename the license DB.

2. Open the license DB and copy the 17 digit registration key you
received from IT4industry to the column “Initial value”.

B LAD/STL/FBD - [DB3 -- "License DB" -- Modbus_PN_CPLIY I — Ol
{3} Fil= Edit Insert PLC Debug Wiew Options ‘Wwindow Help =12 x|
DE&3H S 4 Bal- o|etd|o]|Sa | <> |[OE|N
hddress |Name Type Initial wvalue Comment
0. STRUCT
+0.0 |REG_KEY STRING[17] ['-insert, REG_HEY') Begistration Hey
=E0.0 END_STRUCT
Press F1 ko get Help. 2 |offline labs <52

3. Declare the registration key in the data block as “initial value” to avoid
a repeated insertion after reloading the PLC. Open the data block in
the SIMATIC manager with the editor in the declaration view. Change
over to the data view via the menu “View” -> “Data View”. Choose in
the menu “Edit > Initialize Data Block” — all values of the column
“initial value” are copied to “actual values”.

4. Assign the value “DB3.REG_KEY” to the parameter REG_KEY of the
block MODBUSCP.

5. Transfer the changed blocks to the PLC. The registration key can be
set at run time. A STOP -> RUN transition is not necessary.

The block is now licensed for this CPU.
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Missing or Wrong When the registration key is missing or a wrong one is detected, the SF LED

Licensing (S7-300) or the INTF LED (S7-400) of the CPU is flashing. A cyclic error
message regarding the missing license is displayed in the diagnostic buffer
too. The error number of the missing license is W#16#A090.

F{Module Information - CPU 416-2 DP =100l
Path: |MEIDBUS_TEF’_EF’_EX&MF’LE'\SIM&TIE 4C  Operating mode of the CPLU: Q} RLUM
Statuz 0K Mat a force job
Performance Data | Communication I Stacks I Identification
General i Diagnostic Bufter | Memory I Scan Cpcle Time I Time System
Ewvents: [~ Eilter settings active I~ Time including CRUlocal time difference
T|me of dag Date Ewent

01/001/1934  Ewent 1D: 168 A090

2 1 & 53.04.595 .-’-‘«M 01/00141934  Area lenath eor when reading

3 12:53:00.594 A 01/01/1994  Ewent1D: 164 4090

4 125300534 A 01/0011934  Area lenath errar when reading

A 125256593 AM 01/011934  Ewent1D: 164 4090

E 12:52:6E.593 AM 01/0141934  Area length error when reading

7 12:52:52 532 AM 01/011934  Ewent1D: 168 A090

g 125262592 A 01/00141934  Area length eror when reading j
Detailz on Event: 1of120 Event1D:  16# 4090

Mo entmy in tedt databaze. Hewadecimal walues will be displayed. -

Ewent [D: 1648 4090

OE: 168 01

PE: 164 01

DatlD 14 2: 168 52 C2

Additional infal / 2 4 3 1648 4D4F 4442 5553 LI

Save Az | Settings. . | [pen Block Help on Event |
Cloge | Update | Frint... | Help |

Warning

The CPU will turn to STOP mode, if the OB121 is not available.

Modbus communication is carried out even with a missing or wrong
registration key, but the output STATUS is set to W#16#A090 “no valid
license”.
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5 Function Block MODBUSCP

5.1 Functionality of the FB

General
Information

The function block MODBUSCP allows a communication between a CP443-1
and CP 343-1 and a partner, which supports Open MODBUS/TCP protocol.
The function codes 1, 2, 3, 4, 5, 6, 15 and 16 are supported.

Depending on the parameterization the FB can be operated both in client and
in server mode. It is also possible to operate a CP as a client and as a server
at the same time. In this case two NetPro connections and 2 FB calls are
necessary. In the operating mode server the functionality multitasking,
according to the MODBUS reference, is not implemented.

There is no limitation of the maximum number of parallel called modbus
blocks on the part of the library. Though it depends on the CPU and CP how
many AG functions can run simultaneously. The maximum number of AG
calls can be taken from the manual of the CPU: "Technical Data" >
"Communication"”. In the manual of the CP it's detailed, how many
AG_SEND/AG_RECV or AG_LSEND/AG_LRECYV can be processed by this
CP simultaneously.

The block MODBUSCP calls the blocks MB_CPCLI (FB106) and MB_CPSRV
(FB107) internally. The block MB_CPCLI comprises the function of Modbus
client, the block MB_CPSRYV executes the function of Modbus server.

The function block performs the following functions:

e Calls the standard functions for the data transfer between the CPU
and the CP

e Generates MODBUS specific telegram header before send
e Verification of the MODBUS specific telegram header after receive

e Verification if the memory areas exist which are requested by the
client

e Generate exception telegrams when failures occur (only when CP is
in server mode)

Exception | Meaning
code

1 The requested function code is not supported.

An access to a not existing or not permitted address
was carried out.

2

3 An invalid length was indicated for this function code.
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Online-Help

Call of the FB

Start Up of the FB

Cyclical Operation
of the FB

OB121
“Programming
Error”

e Data transfer to and from the parameterized DB
e Monitoring the data reception with a time-out

o Verification of the registration key
In Simatic Manager an online help for function block MODBUSCP is provided.
Mark the FB and press the key “F1". The online help is displayed; it contains
the main information regarding the FB.

The function block MODBUSCP has to be called in two OBs:
e inthe start up OB100 and
e inacyclic OB (OBL1 or cyclic interrupt OB, e.g. OB35)

In doing so the same instance DB has to be used.
The subordinate blocks of the Modbus library MB_CPCLI and MB_CPSRV
must not be called additionally in an organization block.

A coexistent call of FB MODBUSCP in OB1 and a cyclic interrupt OB, e.g.
OB35 is not permissible.

The OB121 must be available in the CPU. You will find more information
regarding this matter in section “Licensing”.

The function block MODBUSCP should unconditionally be called once in
0OB100.

e The initialization parameters must be set according to the station
configuration.

e The initialization parameters will be evaluated and copied into the
instance DB.

e The runtime parameters are not evaluated during start up.

In cyclical operation the FB MODBUSCP is called in OB1 or a cyclic interrupt
OB.

e According to the runtime parameters, the functions of the function
block are activated.

¢ While a request is running changes to the runtime parameters are
ignored.

e Inthe cyclical operation initialization parameters are ignored.

If the block has not been licensed yet, the OB121 is called.

Warning

The CPU will turn to STOP mode, if the OB121 is not available.
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Initiate Request
CP is Client

Activation of the
Function Block
CP is Server

Data Transfer
CPU-CP

TCP/IP with
CP343-1/CP443-1

Termination of the
TCP connection by
the Communi-
cation Partner

A rising edge at the trigger input ENQ_ENR initiates a request. Depending on
the input parameters UNIT, DATA_TYPE, START_ADDRESS LENGTH and
WRITE_READ a MODBUS request telegram is generated and sent to the
partner station via the TCP/IP connection. The client waits for the
parameterized monitoring time MONITOR for a response from the server.
When the monitoring time elapses (no response from the server) the
activated request is terminated with an error. A new request can be initiated
again.

After the receipt of the response telegram a validity check is carried out. If the
result is positive, necessary actions will be taken and the request will be
terminated without error. The output DONE_NDR is set. When an error is
recognized during verification, the request is terminated with an error, the
ERROR bit is set and an error number is returned in STATUS.

With TRUE signal at the trigger input ENQ_ENR the FB is ready for receiving
a request telegram from the client. The server remains passive.

The received telegram is verified. If the telegram is verified positive, the
response telegram is sent. The completed transmission is reported to the
user by setting the DONE_NDR bit.

At this point the completed function is indicated at the outputs UNIT,
DATA_TYPE, START_ADDRESS, LENGTH and WRITE_READ.

A faulty request telegram causes an error message and the ERROR bit is
set. The error number is returned in STATUS. The request of the client is not
answered.

The data transfer between CP and CPU are done with the standard function
blocks AG_SEND and AG_RECYV respectively AG_LSEND and AG_LRECV.

At the activation of a MODBUS request by the user (CP is client) or at the
receipt of a telegram from the client (CP is server) the standard blocks
necessary for the CP are called by the FB in the right order and number.

At the receipt of a telegram, the first 6 Bytes are read with the function
AG_RECYV. This header contains the length of the rest of the telegram. A
second call of the AG_RECYV function follows with the rest of the telegram
length. The verification of the received user data takes place after the
complete receipt of the data.

TCP/IP with CP 343-1 and CP443-1 uses static connections. The TCP
connection cannot be disconnected while in run mode.

Given this system characteristic, telegrams might be lost under unfavorable
conditions when the synchronization had been lost after an error.

If the CP acts as server and the communication partner terminates the TCP
connection, the next receive can be started not until an idle time of 1 second
has elapsed.

If the CP acts as Client, the next send can be started not until an idle time of
150 milliseconds has elapsed. This delay, due to system characteristics, is
executed by the function block.
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5.2 Parameters of the Function Block MODBUSCP
Parameter Decl. | Type Description Value range | Init
id IN WORD | Connection-ID as per configuration in NetPro lto64 yes
laddr IN WORD | Input-Address of the CP in HW Config CPU yes
dependent
MONITOR IN TIME Monitoring Time: Wait for data from T#20ms to no
communication partner T#+24d20h31
Shortest adjustable time is 20 ms m23s647ms
REG_KEY IN STRING | Registration key to activate the license Character no
[17]
server_client IN BOOL |CP/FB operates in server mode TRUE yes
or client mode (server = slave; client = FALSE
master)
single_write IN BOOL |Write 1 Coil/Register: yes
Function code 5 and 6 are used respectively TRUE
Function code 15 and 16 are used FALSE
respectively
data_type 1 IN BYTE 1st data area: data type yes
Coils 1
Inputs 2
Holding Register 3
Input Register 4
db 1 IN WORD | 1st data area: data block number 1to 65535 | yes
W#16#1 to
WH#164#FFFF
start _1 IN WORD | 1st data area: first Modbus address in this DB | 0 to 65535 | yes
W#16#0000 to
W#16#FFFF
end_1 IN WORD | 1st data area: last Modbus address in this DB | 0 to 65535 | yes
W#16#0000 to
WH#16#FFFF
data_type 2 IN BYTE 2nd data area: data type (Coils, Inputs, Oto4 yes
Holding Register, Input Register),
NULL if not used
db 2 IN WORD | 2nd data area: data block number 1to 65535 | yes
W#16#1 to
WH#16#FFFF
start 2 IN WORD | 2nd data area: first Modbus address in this 0to 65535 | yes
DB W#16#0000 to
WH#16#FFFF
end 2 IN WORD | 2nd data area: last Modbus address in this 0to 65535 | yes
DB W#16#0000 to
WH#164#FFFF
data_type 3 IN BYTE 3rd data area: data type (Coils, Inputs, Oto 4 yes
Holding Register, Input Register),
NULL if not used
db _3 IN WORD | 3rd data area: data block number 1to 65535 | yes
W#16#1 to
WH#164#FFFF
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Parameter Decl. | Type Description Value range | Init
start 3 IN WORD 3rd data area: first Modbus address inthis DB | 0to 65535 | yes
W#16#0000 to
WH#16#FFFF
end_3 IN WORD | 3rd data area: last Modbus address in this DB | 0 to 65535 | yes
W#16#0000 to
WH16#FFFF
data_type 4 |IN BYTE 4th data area: data type (Coils, Inputs, Oto 4 yes
Holding Register, Input Register),
NULL if not used
db 4 IN WORD | 4th data area: data block number 1to 65535 | yes
WH#16#1 to
WH#16#FFFF
start _4 IN WORD | 4th data area: first Modbus address in this DB | 0to 65535 | yes
W#16#0000 to
WH#164#FFFF
end 4 IN WORD | 4th data area: last Modbus address inthis DB | 0to 65535 | yes
W#16#0000 to
W#16#FFFF
data type 5 |[IN BYTE 5th data area: data type (Coils, Inputs, Oto4 yes
Holding Register, Input Register),
NULL if not used
db 5 IN WORD 5th data area: data block number 1to 65535 | yes
WH#16#1 to
W#16#FFFF
start 5 IN WORD 5th data area: first Modbus address in this DB | 0 to 65535 | yes
W#16#0000 to
WH#16#FFFF
end_5 IN WORD | 5th data area: last Modbus address in this DB | 0 to 65535 | yes
W#16#0000 to
WH#16#FFFF
data_type 6 [IN BYTE 6th data area: data type (Coils, Inputs, Oto 4 yes
Holding Register, Input Register),
NULL if not used
db 6 IN WORD 6th data area: data block number 1to 65535 | yes
WH#16#1 to
WH16#FFFF
start _6 IN WORD 6th data area: first Modbus address in this DB | 0 to 65535 | yes
W#16#0000 to
WH#164#FFFF
end 6 IN WORD 6th data area: last Modbus address in this DB | 0to 65535 | yes
W#16#0000 to
W#16#FFFF
data type 7 [IN BYTE 7th data area: data type (Coils, Inputs, Oto4 yes
Holding Register, Input Register),
NULL if not used
db 7 IN WORD 7th data area: data block number 1to 65535 | yes
WH#16#1 to
W#164#FFFF
start _7 IN WORD 7th data area: first Modbus address in this DB | 0 to 65535 | yes
W#16#0000 to
WH#16#FFFF
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Parameter Decl. | Type Description Value range | Init
end 7 IN WORD | 7th data area: last Modbus address in this DB 0to 65535 |yes
W#16#0000 to
WH16H#FFFF
data type 8 |IN BYTE 8th data area: data type (Coils, Inputs, Oto4 yes
Holding Register, Input Register),
NULL if not used
db 8 IN WORD | 8th data area: data block number 1to 65535 |yes
W#16#1 to
WH16H#FFFF
start _8 IN WORD | 8th data area: first Modbus address in this DB | 0 to 65535 |yes
W#16#0000 to
WH16H#FFFF
end 8 IN WORD | 8th data area: last Modbus address in this DB 0to 65535 |yes
W#16#0000 to
WH16#FFFF
ENQ_ENR IN BOOL CP is client: Initiate request at TRUE signal TRUE no
CP is server: Ready to receive at TRUE signal FALSE
LICENSED OUT |BOOL License state of the function block: no
Block is licensed TRUE
Block is not licensed FALSE
BUSY OuUT |BOOL Operating state of the functions AG_SEND no
and AG_RECV
Job processing TRUE
No job processing active FALSE
DONE_NDR |OUT |[BOOL CP is client; Active request finished without TRUE/FALSE | no
errors
CP is server: Request from the client was
executed and answered
ERROR OUT ([BOOL An error has occurred TRUE no
No error has occurred FALSE
STATUS OUT |[WORD | Error number 0 to FFFF no
STATUS_ OUT [ STRINGI [ Name of the function, which causes the error Character no
FUNC 8] at STATUS
IDENT_CODE [OUT | STRING] | Identification for licensing Character no
18] Please order your license with this
identification string.
UNIT IN/ BYTE Unit identification (INPUT if in CLIENT mode, 0 to 255 no
ouT OUTPUT if in SERVER mode)
DATA_TYPE |IN/ BYTE Data type to be accessed: (INPUT if in no
ouT CLIENT mode, OUTPUT if in SERVER mode)
Coils 1
Inputs 2
Holding registers 3
Input registers 4
START _ IN/ WORD | MODBUS start address (INPUT if in CLIENT 0 to 65535 no
ADDRESS ouT mode, OUTPUT if in SERVER mode)
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Parameter Decl. | Type Description Value range | Init
LENGTH IN/ WORD | Number of registers to be processed no
ouT (INPUT if in CLIENT mode, OUTPUT ifin
SERVER mode)
Coils: reading function 1 to 2000
writing function 1to 1968
Inputs: reading function 1 to 2000
Holding Register: reading function 1to 125
writing function 1to123
Input Register: reading function 1to 125
WRITE_ IN/ BOOL INPUT if in CLIENT mode, OUTPUT if in no
READ ouT SERVER mode:
Write access TRUE
Read access FALSE
General The parameters of the FB MODBUSCP can be divided into two groups:
Information

Range of Values

e Initialization parameters
e Runtime parameters

Initialization parameters are evaluated only during the initial execution of the
function block MODBUSCP and taken over into the instance DB. They are
marked in the above table in the column “INIT" with “yes".

A modification of the initialization parameters during run mode has no impact.
After a modification of these parameters (e. g. during the test phase), the
instance DB must be initialized again via a STOP - RUN transition of the
CPU.

Runtime parameters can by modified during the cyclical operation. In the
mode “CP is client”, it is not advisable to modify the input parameters while
a request is active. Wait with the next request and the change of the
parameters until the previous request ends with DONE_NDR or ERROR.

In the operation mode “CP is server”, the output parameters may only be
evaluated when DONE_NDR is TRUE.

The output parameters are displayed dynamically, i.e. they are only
available for one PLC cycle. They have to be copied to an additional memory
area if you need to process them or to display the values in a VAT (STEP7
variable table).

For the range of values of the different parameters, CPU specific restrictions
must be taken into consideration.
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laddr

MONITOR

REG_KEY

server_client

single_write

data_type x

For each configured connection in STEP7 (NetPro) a connection ID is
assigned. The connection ID identifies unambiguously the connection from
the CPU via the CP to the communication partner.

The number from the connection configuration has to be entered here.
The range of values for this parameter is 1 to 64.

The parameter LADDR is the base address of the CP from HW Config (input
address). The configured value has to be entered here.

The range of values for this parameter depends on the CPU.

The parameters ID and LADDR can also be taken from the dialog box
“Properties of TCP Connection”.

The monitoring time MONITOR observes the data input from the
communication partner. The monitoring time can be set in the format T#.... A
monitoring time of approximately 1,5 second is recommended.

In the operating mode “CP is client®* MONITOR specifies the timeout for the
receipt of the complete response telegram from the server. When the
monitoring time elapses, the active request is cancelled with an error. The
timer is started after the completed send of the request telegram and is
stopped after the receipt of the complete data.

In the operating mode “CP is server” the receipt of the second part of the
telegram is monitored with the MONITOR time. When the time elapses an
error is reported. The timer is started after the receipt of the MODBUS specific
telegram header and is stopped after the receipt of the complete request
telegram.

The block MODBUSCP must be licensed for each CPU individually to permit
a correct program sequence. With the registration key REG_KEY the block
MODBUSCEP is licensed and the Modbus communication runs without any
restraint. You can find further information in section “Licensing”.

This parameter differentiates the client from the server mode. If the input is
TRUE, then the operating mode is “CP is server*.
If the input is FALSE, then the operating mode is “CP is Client".

In operating mode “CP is client” and single_write = TRUE write requests with
length 1 are carried out with the function codes 5 and 6.

With single_write = FALSE all write requests use the function codes 15 and
16.

The parameter data_type_x defines the MODBUS data type which is to be
mapped with this definition.
If data_type_x set to 0, this data area is not used.

Identifier | Data type Size

0 Area not used

Coils Bit

Inputs Bit

1
2
3 Holding Register | Word
4 Input Register Word

OPEN MODBUS / TCP communication via CP343-1 and 443-1 5-8
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db_x The parameter db_x defines the number of the data block in which the
consecutively defined MODBUS registers or bits are mapped.
0 cannot be used as DB number since it is reserved for system functions.

db x

DB-Number 1 - 65535 (W#16#0001 to W#16#FFFF)
start_x Start_x specifies the first register or bit address, which is stored in the data
end_x element O of the DB. End_x defines the last MODBUS address.

When accessing registers, the number of the data element of the S7 DB in
which the last register is mapped, can be calculated with the following
formula:

DBW number = (end_x — start_x) * 2

When accessing coils or inputs, the number of the data element of the S7 DB
in which the last bit is mapped, can be calculated with the following formula:

DBB number = (end_x —start x+7)/8

The defined memory areas must not overlap. The parameter end_x must not
be smaller than start_x. In case of an error occurring, the initialization of the
FB is stopped with an error. When start_x is equal to end_x, one Modbus
address (1 register or 1 bit) is allocated.

In section 5.3 you can find an example of the mapping of the MODBUS
addresses to S7 memory areas.

ENQ_ENR Operating mode “CP is client*:
The data transfer is initiated with a TRUE signal at the input. The request
telegram is generated with the values of the input parameters UNIT,
DATA_TYPE, START_ADDRESS, LENGTH and WRITE_READ. A new
request may only be initiated, when the previous one is ended with DONE or
ERROR.

Operating mode “CP is server*:

The FB is activated with a TRUE signal at the input. Telegrams from the client
can be received. With a FALSE signal at the input data is received from the
CP and discarded.

LICENSED If this output is TRUE, then the Modbus block is licensed on this CPU. If the
output is FALSE, none or a faulty license string was typed in. You can find
further information in section “Licensing”.

BUSY If this output is TRUE, one of the functions AG_SEND or AG_RECV is
running.
OPEN MODBUS / TCP communication via CP343-1 and 443-1 5-9
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DONE_NDR

ERROR

STATUS

STATUS_FUNC

IDENT_CODE

UNIT

In the operating mode “CP is client” the activated request was executed
without error. For a read function the response data from the server has
already been entered into the DB. For a write function the response to the
request telegram has been received from the server.

In the operating mode “CP is server” this output indicates a telegram
exchange without errors. In the parameters UNIT, DATA_TYPE,
START_ADDRESS, LENGTH and WRITE_READ the request parameters of
the client are displayed. These outputs are only available and valid as long as
DONE_NDR is TRUE.

When this output is set, an error was recognized.

In the operating mode “CP is client” the activated request was ended with an
error. The error number is displayed in the STATUS output.

In the operating mode “CP is server” an error is detected at a request
telegram of the client or at sending a response telegram. The error number is
displayed in the STATUS output.

The STATUS output displays the error number when ERROR is TRUE. The
error numbers are described in chapter 6.

This parameter shows the name of the function, which caused the error
occurred.

After start-up of the PLC this parameter displays the identification code, an 18
character string. With this IDENT_CODE you can order the registration key at
IT4industry.

You can find further information in section “Licensing”.

In mode “CP is client” the parameter UNIT is an input parameter. This input
has to be set according to the requirements. The FB copies this value to the
request telegram and verifies when the respond telegram is received.

In mode “CP is server” the parameter UNIT is an output parameter. The FB
copies this value from the request telegram to the respond telegram. The
output is set with the received value when the job is finished without error.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 5-10
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DATA_TYPE

START_ADDRESS

LENGTH

The parameter DATA_TYPE defines which Modbus data type is to be
accessed with the current job. The following data types are available:

Coils B#16#1
Inputs B#16#2
Holding Register B#16#3
Input Register B#16#4

In the operating mode “CP is client”, DATA_TYPE is an input parameter. In
the operating mode “CP is server”, DATA_TYPE is an output parameter.

The different data types are related directly to the used function codes.

Data type DATA_ | Function | Length | single_ Function
TYPE write code
Coils 1 read any irrelevant 1
Coils 1 write 1 TRUE 5
Coils 1 write 1 FALSE 15
Coils 1 write >1 irrelevant 15
Inputs 2 read any irrelevant 2
Holding Register 3 read any irrelevant 3
Holding Register 3 write 1 TRUE 6
Holding Register 3 write 1 FALSE 16
Holding Register 3 write >1 irrelevant 16
Input Register 4 read any irrelevant 4

The parameter START_ADDRESS specifies the first MODBUS address that
is read or written.

In the operating mode “CP is client” itis an input parameter, in the operating
mode “CP is server” it is an output parameter.

The parameter LENGTH specifies the number of MODBUS registers or bits
that are read or written.

In the operating mode “CP is client” it is an input parameter. In the operating
mode “CP is server” it is an output parameter.

For read functions, a maximum of 125 registers or 2000 bhits is possible per
telegram. For write functions a maximum of 123 registers or 1968 bits is
possible.

All registers or bits have to be in the same DB per telegram.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 5-11
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WRITE_READ

This parameter defines if a read or write function should be carried out. If the
value of the input/output is FALSE, it specifies the read mode. The value
TRUE specifies the write mode.

Only Holding Registers and Coils can be written. Input Registers and Inputs
can be read merely.

In the operating mode “CP is client it is an input parameter. In the operating
mode “CP is server" it is an output parameter.

5.3 Address Mapping

Interpretation of
Modbus
Addresses

MODBUS bases its data model on a series of tables, which have
distinguishing characteristics. The distinction between these memory areas is
done via the register address by some systems, e.g. MODICON PLCs. So a
MODBUS message requesting the read of a holding register at offset 0 would
return the value known to the application programmer as found in register
40001 (memory type 4xxxx, reference 0001).

One potential source of confusion is the varying interpretation of the register
address in different manuals. Sometimes the register address means the
address of the application layer, sometimes the address transferred.

The FB MODBUS uses the Modbus address transferred at its parameters
start_x und START_ADDRESS. So it is possible to use register addresses
from von 0000, to FFFF4 with each function code.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 5-12
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Example:
Parameterization
of the Memory
Areas

Address Mapping

data_type 1 B#16#3 Holding Register
db_1 W#16#B DB 11

start 1 WH#16#1 Start address: 1
end 1 W#16#1F4 End address: 500
data_type 2 B#16#3 Holding Register
db_2 W#16#C DB 12

start 2 W#16#2D0 Start address: 720
end 2 W#16#384 End address: 900
data_type 3 B#16#4 Input Register
db_3 W#16#D DB 13

start _3 W#16#2D0 Start address: 720
end 3 W#16#3E8 End address: 1000
data_type 4 B#16#0 Not used

db_4 0 0

start 4 0 0

end 4 0 0

data_type 5 B#16#1 Coils

db_5 WHI16#E DB 14

start 5 W#16#280 Start address: 640
end 5 W#H16#4E2 End address: 1250
data_type 6 B#16#2 Inputs

db_6 WH#16#F DB 15

start 6 WH#16#6A4 Start address:1700
end 6 W#16#8FC End address: 2300
data_type 7 B#16#1 Coils

db_7 W#16#10 DB 16

start _7 W#16#6A4 Start address: 1700
end 7 W#16#8FC End address: 2300
data_type 8 B#16#0 Not used

db_8 0 0

start 8 0 0

end 8 0 0

The following diagram shows the comparison of the SIMATIC memory area
and the Modbus typical register oriented storage arrangement. The diagram
is based on the above parameterization.

The Modbus addresses printed in black refer to the Data Link Layer, the ones
printed in grey refer to the Application Layer.

The SIMATIC addresses printed in black are the offset in the DB. You can
find additionally the Modbus register numbers printed in grey.
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5.4 Data and Standard Functions used by the FB

Instance DB

Local Variables

Timers
Flags

Standard FCs for
Data Transfer

The function block MODBUSCRP stores its data in an instance DB. This
instance DB is created by STEP7 at the first call of the FB.

The instance data block contains parameters of type Input, Output,
Input/Output as well as static variables that it needs for its execution. These
variables are non-volatile and keep its validity between FB calls. The
variables control the internal process flow of the FB.

Required memory of the instance-DBs:

Instance-DB | work memory | load memory
MODBUSCP | ca. 1kByte ca. 2kByte

The FB requires 80 Bytes of local variables. Additionally the subordinate FBs
require local variables: FBs MB_CPCLI (30 byte) or MB_CPSRYV (30 byte).
V1.x: AG_SEND/AG_RECV or AG_LSEND/AG_LRECV require, up to 58
bytes, depending on the used function block. That gives a maximum of 168
bytes of local data for a FB MODBUSCP V1.x-call.

V2.x: The function AG_CNTRL requires 178 bytes local data. That gives a
maximum of 288 bytes of local data for a FB MODBUSCP V2.x-call.

The function block does not use any timer.
The function block does not use any flag.

The function blocks MB_CPCLI and MB_CPSRYV respectively called by FB
MODBUSCP use the blocks AG_SEND/AG_RECV (S7-300) and
AG_LSEND/AG_LRECV (S7-400) from the SIMATIC_NET library for the data
transfer between CPU and CP.

The blocks MODCLI and MODSRY version 2.x use the block AG_CNTRL
additionally to reset and reestablish the connection in case of error.

The following versions of the FCs are tested with FB MODBUSCP and
released for the communication:

S7-300: FC5 “AG_SEND" version 4.2
FC6 “AG_RECV* version 4.7
FC10 “AG_CNTRL" version1.0

S7-400 FC50 “AG_LSEND" version 3.1
FC60 “AG_LRECV* version 3.1
FC10 “AG_CNTRL" version 1.0
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MODBUSCP:
SFCs for
Miscellaneous
Functions

MB_CPCLI and
MB_CPSRV:
SFCs for
Miscellaneous
Functions

OPEN MODBUS / TCP communication via CP343-1 and 443-1

The FB MODBUSCP uses the following SFBs/SFCs from the standard library:

SFB4 ,TON*

SFC6 ,RD_SINFO*
SFC20 ,BLKMOV*
SFC51 ,RDSYST”
SFC52 ,\WR_USMSG

The FBs MB_CPCLI and MB_CPSRYV use the following SFCs from the
standard library:

SFC20 ,BLKMOV*
SFC24 ,TEST_DB”
SFB4 ,TON*
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5.5 Renaming of Standard Functions

Inducement Whether you have already used the numbers of standard functions in your
project or the block number is reserved for a different application, you may
rename the internal called functions FC5/FC50 or FC6/FC60, FC10 or the
blocks MODBUSCP, MB_CPCLI and MB_CPSRV.

It is not possible to rename the system functions SFC6, SFC20, SFC24,
SFC51 and SFC52 as well as the system function block SFB4.

Behavior A set of rules concerning the function block numbering have to be considered
when rewiring function blocks in SIMATIC STEP 7 Manager.

If you want to rewire the blocks of the Modbus library, the following sequence
is required:

1. FC50 AG_LSEND
FC60 AG_LRECV

2. FB106 MB_CPCLI
FB107 MB_CPSRV

3. FB108 MODBUSCP

It is not necessary to rewire all blocks. Even if you want to rewire only some of
the blocks, you must follow the mentioned sequence.

Renaming To rename the blocks proceed as described subsequently:

1. Get the information about the used operand by clicking "Extras >
Reference data > Display".

2. Set the operand priority in the object properties of the block folder to
"Absolute value".

3. Call the function "Extras > Re-wire" in the SIMATIC Manager, in order
to re-wire the operands into free areas.

4. To be able to keep on using the symbolism diagnostics tools, add the
modifications in the symbolism table supplementary.

The modifications can be verified by clicking "Extras > Reference data >
Display".
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6 Diagnostics

Diagnostic
Function

Display Elements
(LED)

STATUS Output of
the FB
MODBUSCP

The diagnostic functions of the CP 343/ CP 443 allow you fast failure
localization. The following diagnostic features are available:

e Diagnostics via the display elements of the CP
e Diagnostics via the STATUS output of the function block MODBUSCP.

The display elements inform you about the operating mode or about the
failure conditions of the CP. The display elements give you an overview of
internal failures, external failures and interface specific failures.

For error diagnostics, the function block MODBUSCP has got a STATUS
output. By reading the STATUS output you get a general indication of failures
that have occurred during the communication. The STATUS parameter can
be evaluated in the user program.

The output STATUS_FUNC shows the name of the function, which has
caused the error.

6.1 Diagnostics via the Display Elements of the CP

Display Functions

The display elements of the CP give you information on the module status.
There are two types of display functions:

e Group Error Displays

-INTF Internal failure
- EXTF External failure

e Special Displays

CP 343-1:
-RXITX  Atelegram is being transmitted via the interface.

CP 443-1:
- TXD A telegram is being sent via the interface.
- RXD A telegram is being received via the interface.

A detailed description of the display elements can be found in the device
manual of the CP.

OPEN MODBUS / TCP communication via CP343-1 and 443-1 6-1
2XV9450-1MBO00; Manual edition 4.3



Diagnostics

6.2

Messages at the
STATUS Output of

the FB

Error Messages of
the called SFCs

and FCs

Diagnostic Messages of the FB MODBUSCP

The block MOBUSCP has got 2 status outputs: STATUS and
STATUS_FUNC. STATUS displays all error numbers. STATUS_FUNC shows

the name of the function, which caused the error. STATUS is valid when
ERROR is TRUE. Below you can find a list of FB-specific error messages.

The FB MODBUSCP, MB_CPCLI and MB_CPSRYV use the standard
functions SFC6, SFC20, SFC24, SFC51, SFC52, FC5 and FC6, or FC50 and

FC60. The error messages of these blocks are passed on to STATUS without

any changes.

In the diagnostics buffer or in the online help of SIMATIC Manager you will
find further details on these error messages, as well as in the SIMATIC

STEP7 NCM S7 Industrial Ethernet Manual.

Error messages of FB MODBUSCP

STATUS | Event text Remedy
(Hex)
A002 | The parameter end_x is less than start_x. Correct the parameterization of

start_x and end_x

The number of registers/bits in the request telegram is
invalid. The CP sends an exception telegram.

Range of values:

Read coils/inputs: 1 to 2000
Write coils: 1 to 1968

Read registers: 1 to 125

Write holding registers: 1 to 123

A003 | The DB, to which MODBUS addresses shall be Extend the DB.
mapped, is too short. CP is Client: Correct the
Minimum length: parameters START_ADDRESS
registers: (end_x—start x+1) *2 or LENGTH
bits: (end_x -start x)/8+1

. CP is Server:
Other possible reasons: ) .
Fpossi o S _ S _ o Modify the request of the client.
e Wrong initialization parameter (CP is client).
e Wrong address area in the request telegram of
the client (CP is server). The CP sends an
exception telegram.

A004 | Applies only with CP is client: Correct the parameters. Only
An invalid combination of DATA_TYPE and data type 1 or 3 can be written.
WRITE_READ is given.

A005 | CPis client: CP is Client:

An invalid value for the parameter LENGTH is given. Correct the parameter LENGTH.
CP is Server: CP is Server:

Modify the number of
registers/bits in the request
telegram.

OPEN MODBUS / TCP communication via CP343-1 and 443-1
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Error messages FB MODBUSCP

STATUS | Event text Remedy
(Hex)
A006 | The given range of data defined with DATA_TYPE, CP is Client:

START_ADDRESS and LENGTH does not exist in
data_type_1 to data_type_8.

CP is server:

The CP sends an exception telegram.

Correct the parameter’s
combination DATA_TYPE,
START_ADDRESS and
LENGTH.

CP is Server:

Modify the request of the client
or correct the parameterization
of data_type_x.

A007 |CP s client: Correct the parameterization.
An invalid monitoring time MONITOR is parameterized.

A value > 20ms is required.

A008 | Monitoring time MONITOR elapsed when AG_RECV Verify error messages at the
waits for receipt. E.g. Partner is not ready. communication partner.
MODBUSCP V2.x: _ Check if the communication
All connections via Port 502 are terminated and partner needs a special unit
reestablished. identifier.

MODBUSCP V1.x:
As an after effect the loss of synchronization can occur,
which leads to a loss of telegrams.

A009 | CP is client: The received transaction identifier Tl is not | Verify the data of the
equal to the sent one. communication partner with the
MODBUSCP V2.x: help of a telegram trace.

All connections via Port 502 are terminated and
reestablished.

AOOA | CPis client: The received UNIT is not equal to the sent
one.

MODBUSCP V2.x:
All connections via Port 502 are terminated and
reestablished.
AO0OB [CP s client: CP is client:
Received function code is not equal to the sent one. Verify the data of the
CP is server: communication partner with the
An invalid function code was received. The CP sends help of a telegram trace.
an exception telegram. CP is server:
MODBUSCP V2.x: The FB MODBUSCP supports
All connections via Port 502 are terminated and the function codes 1, 2, 3, 4, 5,
reestablished. 6,15 and 16.
MODBUSCP V1.x:
As an after effect the loss of synchronization can occur,
which leads to a loss of telegrams.

AQOC | The received byte count does not match the number of | Verify the data of the
registers/bits. communication partner with the
CP is server: The CP sends an exception telegram. help of a telegram trace.
MODBUSCP V2.x:

All connections via Port 502 are terminated and
reestablished.

AO0OD | Only when CP is client: The register/bit address or the

number of registers/bits in the response telegram is not
equal to the one in the request telegram.
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Error messages the FB MODBUSCP

STATUS | Event text Remedy
(Hex)
AOOE | The length indicated in the MODBUS specific telegram | Verify the data of the

header does not match the number of registers/bits or
the byte count in the telegram. The FB receives all data
and ignores them.

MODBUSCP V2.x:

All connections via Port 502 are terminated and
reestablished.

MODBUSCP V1.x:

As an after effect a loss of synchronization might occur.

AOOF

A protocol identifier <> 0 was received.

MODBUSCP V2.x:

All connections via Port 502 are terminated and
reestablished.

MODBUSCP V1.x:

As an after effect a loss of synchronization might occur.

communication partner with the
help of a telegram trace.

A010

In the parameterized area db_1 to db_8 a DB number is
used twice.

Correct the parameterization of
db_x.

A011

An invalid value for DATA_TYPE is given (Value range:
1to 4).

Correct the parameters.

A012

The parameterized areas data_type 1 and data_type_2
overlap.

A013

The parameterized areas data_type 1 and data_type 3
overlap.

A014

The parameterized areas data_type 1 and data_type 4
overlap.

A015

The parameterized areas data_type 1 and data_type 5
overlap.

A016

The parameterized areas data_type 1 and data_type 6
overlap.

A017

The parameterized areas data_type 1 and data_type 7
overlap.

A018

The parameterized areas data_type 1 and data_type_ 8
overlap.

Correct the parameterization.

The data areas must not contain
any overlapping register areas.

A019

0 is assigned to one of the parameters db_x while the
according data_type xis <> 0.
DB 0 can't be used; it is reserved for system functions.

Correct the parameterization of
db_xto>0.

AO1A

Wrong length in header:
Range of values: 3 to 253 bytes.

MODBUSCP V2.x:
All connections via Port 502 are terminated and
reestablished.

AO01B

CP is server and function code 5:
An invalid value for coils was received.
The CP sends an exception telegram.

Verify the data of the
communication partner with the
help of a telegram trace.
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Error messages of FB MODBUSCP

STATUS | Event text Remedy
(Hex)
AOl1E | The CP has received invalid data which could not be Check the error message of the

assigned.

MODBUSCP V2.x:

All connections via Port 502 are terminated and
reestablished.

MODBUSCP V1.x

The CP has lost synchronization and needs data from
the communication partner to finish the active
AG_RECV.

communication partner and verify
the data with a telegram trace if
needed.

AO1F | The FB MODBUSCP has turned to an invalid state. Please contact the product
support.
A023 | The parameterized areas data_type_ 2 and Correct the parameterization.
data_type_3 overlap. The data areas must not contain
A024 | The parameterized areas data_type 2 and any overlapping register areas.
data_type_ 4 overlap.
A025 | The parameterized areas data_type 2 and
data_type 5 overlap.
A026 | The parameterized areas data_type 2 and
data_type_6 overlap.
A027 | The parameterized areas data_type_ 2 and
data_type_7 overlap.
A028 | The parameterized areas data_type 2 and
data_type_ 8 overlap.
A034 | The parameterized areas data_type_ 3 and
data_type_ 4 overlap.
A035 | The parameterized areas data_type_3 and
data_type_ 5 overlap.
A036 | The parameterized areas data_type_3 and
data_type_6 overlap.
A037 | The parameterized areas data_type_ 3 and
data_type_ 7 overlap.
A038 | The parameterized areas data_type 3 and
data_type_8 overlap.
A045 | The parameterized areas data_type 4 and
data_type_ 5 overlap.
A046 | The parameterized areas data_type_4 and
data_type_6 overlap.
A047 | The parameterized areas data_type 4 and
data_type_ 7 overlap.
A048 | The parameterized areas data_type 4 and
data_type_8 overlap.
A056 | The parameterized areas data_type 5 and
data_type_6 overlap.
A057 | The parameterized areas data_type_5 and
data_type_7 overlap.
A058 | The parameterized areas data_type 5 and

data_type_8 overlap.
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Error messages of FB MODBUSCP

STATUS | Event text Remedy
(Hex)
A067 | The parameterized areas data_type_6 and Correct the parameterization.

data_type_7 overlap.

The data areas must not contain

AO068 | The parameterized areas data_type_6 and any overlapping register areas.
data_type_8 overlap.

A078 | The parameterized areas data_type 7 and
data_type_ 8 overlap.

AO7A | Aninvalid value id is parameterized. Range of values is | Correct the parameterization of
1to 64. the input id.

A07C | Aninvalid value data_type x was given. The value Correct the parameterization of
range is 0 to 4. data_type x.

A07D |Parameter data_type_1 is not defined. The parameter | Correct the parameterization of
area _1 is the default area and must be defined. data_type_1.

AO7E | The DB number of db_x is identical to the number of Correct the parameterization of
the instance DB. db_x.

A080 Different instance DBs were used for the call of MODBUSCP must be called with
MODBUSCP in OB100 and the cyclic OB. the identical instance DB in

OB100 and the cyclic OB.

A081 | Onlyif CP is client and function code 5: Verify the data of the
The received coil status is not equal to the sent one. communication partner with the

help of a telegram trace.

A082 Only if CP is client and function code 6: Verify the data of the
The received register value is not equal to the sent one. | communication partner with the

help of a telegram trace.

A083 Only if CP is client: Wait with the initiation of a new
A request was initiated prior to the completion of the request until the previous one
previous one. The request is not executed. was finished either with

DONE/NDR = TRUE or ERROR
= TRUE.

A085 | An error occurred during the license handling due to an | Verify the project if there is any
invalid write access. invalid write access to the license

DB. The structure of REG_KEY
must not be changed. Please
contact the Product Support if
necessary.

A090 | The block MODBUSCP is not licensed for this CPU. Read the identification string

This is a status information. The bit ERROR is not set.
The Modbus communication runs without a license as
well.

IDENT_CODE for this CPU and
order the registration key at
IT4industry.

See also section “Licensing”.
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Diagnostics

Error messages of FB MODBUSCP

STATUS | Event text Remedy
(Hex)
A091 | An exception telegram with exception code 1 was The communication partner does

received (only if CP is client)

not support the requested
function.

A092 | An exception telegram with exception code 2 was Correct LENGTH or
received (only if CP is client) START_ADDRESS at the call of
An attempt to an invalid or non existing address at the the FB.
communication partner was made.
A093 | An exception telegram with exception code 3 was The communication partner can'’t
received (only if CP is client) process the received request
(e.g. doesn’t support the
requested length).
A094 | An exception telegram with exception code 4 was The communication partner is in
received (only if CP is client) a state, in which the received
request can't be processed.
A095 | An exception telegram with an unknown exception Check the error message of the

code was received (only if CP is client).

communication partner and verify
the data with a telegram trace if
needed.
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6.3

6.4

6.5

Diagnostics

Diagnostic Messages of FC5/FC6 and FC50/FC60

Diagnostic messages of the included blocks AG_SEND/AG_RECV (FC5/FC6) and

AG_LSEND/AG_LRECV (FC50/FC60) at the output STATUS

STATUS | Event text Remedy
(Hex)
TXXX For detailed information please refer to the online help | See online help (SIMATIC

of SIMATIC Manager.

manager -> mark block -> key F1
—> Ethernet -> see also -> code
evaluation )

8XXX

For detailed information please refer to the online help
of SIMATIC Manager.

See online help (SIMATIC
manager -> mark block -> key F1
—> Ethernet -> see also -> code
evaluation )

Diagnostic Messages of included FCs/SFCs

Diagnostic messages of the included blocks RD_SINFO (SFC6), BLKMOV (SFC20) , SFC51
(RDSYSST), SFC52 (WR_USMSG) and AG_CNTRL at the output STATUS

STATUS | Event text Remedy
(Hex)
TXXX For detailed information please refer to the online help | See online help (SIMATIC

of SIMATIC Manager.

manager -> mark block -> key F1)

8XXX

For detailed information please refer to the online help
of SIMATIC Manager.

See online help (SIMATIC
manager -> mark block -> key F1)

Diagnostic Messages of SFC24

Error messages of SFC24

STATUS | Event text Remedy
(Hex)
80A1 DB Number = 0 or too large for the CPU Choose a valid DB number.
80B1 | The DB does not exist in the CPU. All data blocks that are specified
in db_x must be created and
copied into the CPU.
80B2 |DB UNLINKED DB must not be created as

UNLINKED.
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Application Sample

7 Application Samples

General With the installation 2 sample projects are installed in \Program
Information Files\Siemens\Step7\Examples.

e sample project “MB_TCP_CP” written in STL and

e sample project “MB_TCP_CP_CFC” written in CFC

The S7 programs are for information purposes only and are not to be
understood as a solution for a customer specific installation configura-

tion.
Programming The programming examples consist of the blocks:
Example e Start-Up OB100

Programming error OB121

Cyclic program processing OB1 and OB35 respectively with call of FB 108
Global DB for job trigger (e.g. via a variable table) and for licensing

Data blocks for register values
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Application Sample

Sample project STL

General The sample project written in STL includes serveral Simatic stations for the
Information different applications.
e Simatic Station is S7-300 or S7-400
e Simatic Station is client or server
e Simatic Station supports or doesn’t support AG_CNTRL
5, MODBUS_TCP_CP_EXAMPLE -- C:\Program Files)Siemens\Step7iexamples', —1ol x|
= MODBUS_TCP_CP_EXAMPLE Object nhame Symbolic name | ... | Type | Wersion [Hes
—-{l Cur_SIMATIC 400(Client) 25 Spstem data 40):]
@ cru nie2ppP o081 CYEL_EXC STL  Organization Block 01
B&n 57 Froaiamt) o 08100 COMPLETE RESTART STL  OrgarieationBlock 0.0
g %S o 0821 PROG_ERR STL  Organization Block 0.1
o P 42T Anced & FE108 ME_CPCLI SCL  Function Black 22
Con, SIMATIC 400G erver & FE107 ME_CPSRV SCL  Function Black 21
Frev_ SIMATIC 400(Client &FFE108 MODBUSCP SCL  Funcion Block 22
Frov SIMATIC 400(Server | |82 FC10 AG_CNTRL STL  Function 1.0
Prev_SIMATIC 3000Client] & Frsn AG_LSEND ST Function a1
-] Prev_SIMATIC 300[Server) £FFCED AG_LRECY STL  Function 31
D1 CONTROL DAT DE  DataBlack 01
S DE3 LICENSE_DE DE  DataBlock o1
DB DATA_AREA_1 DE  DataBlack a1
o012 DATA_ARES_2 DE  DataBlock o1
©DE13 DATA_AREA_3 DE  DataBlack 01
S DET4 DATA_AREA_S DE  DataBlock o1
3 DE1S DATA_AREA_B DE  DataBlack a1
o DE1E DATA_AREA_T DE  DataBlock 01
iFDe102 IDE_MODEUS DB Instance data block .. 0.0
92 Cliert_Job Client_Job “Yariable Table 01
&F 5FB4 TOM 5TL  Spstem function block 1.0
&F SFCE ROD_SIMNFO STL  Swstem function 1.0
3 SFC20 BLEMOYW STL  Systemn function 1.0
&3 SFC24 TEST_DBE STL  System function 1.0
&% 5FCH1 RDSYSST STL  Swstem function 1.0
&F SFCE2 wR_USMSGE STL  Swstem function 1.0
K [ | 2|
Used Blocks The subsequent listed blocks are used in the provided example project for S7

stations with FB MODBUSCP.

Block Symbol Comment

OB 1 CYCL_EXC Cyclic program processing

OB 100 COMPLETE Start-Up OB for Re-Start
RESTART

OB 121 PROG_ERR Programming error OB

FB 108 MODBUSCP User block FB MODBUSCP

FB 106 MB_CPCLI Internally called FB MB_CPCLI

FB 107 MB_CPSRV Internally called FB MB_CPSRV

DB 1 CONTROL_DAT Work-DB CONTROL DAT for FB MODBUSCP

DB 3 LICENSE_DB License DB for FB MODBUSCP

DB 11 DATA_AREA_1 Value DB for area 1

DB 12 DATA_AREA_2 Value DB for area 2

DB 13 DATA_AREA_3 Value DB for area 3

DB 14 DATA_AREA_5 Value DB for area 5

DB 15 DATA_AREA_6 Value DB for area 6

DB 16 DATA_AREA_7 Value DB for area 7

DB 108 IDB_MODBUS Instance DB for FB MODBUSCP
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Application Sample

7.2 Sample project CFC

General The sample project written in CFC includes two Simatic S7-400 stations, one
Information is parameterized as client, the other one as server.

46e7FC—y Jaddy Busy Bol—
42_20%ws—{11 MONITOR ||[DONE NOE Bo
B3 _REG_REY, REG_KEY EEROR BO
B0 sevvar = | ]
a—B0 sinsle wd £TATUS FU S
464 5—BY daka_tupd TDENT _cOD Sni—
FL TR
6= ctark 1
4681F4—ly ang 3
464 5—BY daka_tup
agsc—db
168208y skart 2
468554l _end 2
464 +—BY daka_tap
60— _a
160208y
1685E5—]
61—
A6=E—
16u 250
a6usE2—il
64 2B
FLACE
.
ot

FLIETS:
160 5FC—]

A6#1—BY dakta_tup Save STATUS 'W
] e
Used Blocks The subsequent listed blocks are used in the provided example project with

FB MODBUSCP. The system functions, system function blocks and the
blocks which are generated by CFC are not listed in the following table.

Block Symbol Comment
OB 35 CYC_INT5 Cyclic program processing
OB 100 COMPLETE Start-Up OB for Re-Start
RESTART
OB 121 PROG_ERR Programming error OB
FB 8 R_TRIG Recognition of positive edge
FB 24 CTU Upwards counter
FB 99 Save_STATUS FB to save the error number and the name of the
according function
FB 106 MB_CPCLI Internally called FB MB_CPCLI
FB 107 MB_CPSRV Internally called FB MB_CPSRV
FB 108 MODBUSCP User block FB MODBUSCP
FC 500 AG_LSEND FC to send data
FC 600 AG_LRECV FC to receive data
DB1 MEMORY_DB Help DB in server mode
DB 3 LICENSE_DB License DB for FB MODBUSCP
DB 11 DATA_AREA_1 Value DB for area 1
DB 12 DATA_AREA_2 Value DB for area 2
DB 13 DATA_AREA_3 Value DB for area 3
DB 14 DATA_AREA_5 Value DB for area 5
DB 15 DATA_AREA_6 Value DB for area 6
DB 16 DATA_AREA_7 Value DB for area 7
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Fax: ++49 9131 7-44757

Mail: it4.industry@siemens.com
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